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If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

BAS Monthly Tip Sheet 
 Permit Safeguards 

New safeguard options have been implemented to prevent the issuance of an application or the completion of 
a permit record unless all fees are paid, all inspections are passed, and/or all approvals have been approved. 

Check the boxes to enable any 

safeguards which you desire.    

Prevent Permit Issuance allows you to 

the stop the issuance of a permit.  

Prevent Permit Completion allows you 

to the stop the completion of an issued 

permit.   

Under the File menu, click 
System Preferences.   

These switches are located 
in the Permit tab. 

Note: These safeguards can be easily turned off if you decide you no longer wish to have them active. 

Simply go back into the System Preferences and uncheck those you wish to disable.    

The Action button will not allow the user to proceed until 

all conditions are met.  The items which need to be 

addressed will display in red.    

Once all conditions are met, the OK button will become 

live and the user can continue forward.    
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BAS Monthly Tip Sheet 
 Adding new Owners to Parcels 

 
 

 

           

  
 
 
 
 

  

 

 

 

 

  

 

 

 

 

 

The OWNERS tab allows users to add and/or 

deactivate owners on a parcel.   

This feature is located on the Parcel window.   

Search for and open the intended parcel, then 

click on the OWNERS tab.    

 

New owners may be added through the Assessment Sync 

tool or manually.  

To add a new owner manually: 

 Click ADD OWNER.  The address book window will 

appear.  Users can search for an existing contact or 

add a new one.   

 

 Click CLOSE on the address book.  

 

 Click SAVE in the Parcel Window to commit the 

transaction.  The new owner will appear in the list. 

 

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

To deactivate an owner:   

 Highlight the individual you wish to 

deactivate. Click DEACTIVE. 

 

 Click SAVE to commit the transaction.  

 

 The deactivated owner will now move down 

to “Previous owners” section.    

 

 

 

 
 

IPS Tip: By clicking this icon, the contact can be added from assessment into the Address Book 

or synchronized with an existing contact.  

 

Note: To maintain ownership history on a parcel, it is highly recommended that the user not remove, 

but deactivate previous owners.   The only time the REMOVE button should be used is when an 

owner was entered in error. 
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BAS Monthly Tip Sheet 
 Editing Collections 

 
 

 
 
 

 
 
      

       
              

                                                                                                             

 

 

 

 

 

 

 

 

 

 

 

 

The Edit Collections feature allows the user to filter certain record data directly at print time. This makes it easy 

to quickly tailor a form to your needs without having to create an entirely new version for each circumstance 

that arises. 

Some common uses for this feature include filtering out already remedied violations from a violation notice or 

choosing a specific record contact for a form that might vary each time (Business Contact, Owner, Tenant, etc.). 

  

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

EDIT COLLECTIONS is located at the top-left of the print 

preview screen, which is shown after selecting your desired 

form. 

Clicking the EDIT COLLECTIONS button will display a list of 

data on the record which is available for filtering (e.g. 

contacts, inspections, violations, and actions). 

 

To choose the data you would like displayed, 

simply use the checkboxes to toggle certain 

items on and off. 

After a change is made, a few seconds will 

elapse and the form will refresh to reflect the 

newly filtered data.  

 
 
 
 
 
 

 
 
 

NOTE:  If you are on a version earlier than 3.97, you will not have the Check All or Uncheck All 
enhancement.   You will need to manually check and uncheck the items you wish to display.      
 

mailto:support@basgov.com
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BAS Monthly Tip Sheet 
 Address Book: Insurance/Adding Attachments 

 
 

 

            
    

 

                                        

      
 

 

   

Worker’s Compensation, Liability, and Disability 

insurance can be tracked within the IPS program 

alerting Users when policies have expired. 

 

Within the SEARCH tab, choose ADDRESS BOOK 

and search for the desired Contractor. When the 

CONTRACTORS box is checked the INSURANCE tab 

becomes active. 

Click on the INSURANCE tab and choose ADD.  Fill in 

the desired information and SAVE. 

NOTE: When adding the Contractor to a record, the 

contact will show in red font when the policy has 

expired. 

Attachments, such as, Certificates of Insurance can 

be added to Contacts within the Address Book. 

Click on ATTACHMENTS followed by NEW 

ATTACHMENT and locate the desired document 

within your files. 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 
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BAS Monthly Tip Sheet 
 Zone Types 

 
 

 

 

 

 

 

            
    
 

 

                                        

      
 
 

 
 

 

 

 

 

   

To add a new Zone type, Go to MAINTAIN > ZONE 
TYPES and click on NEW.  
 

 Name- The display name of the zone type. 

 Description- Description of the zone (optional). 
 
Click SAVE. 

 

If a zone type is no longer desired, select the Zone 

Type from the dropdown list, uncheck the Active box, 

then click SAVE.    

 

 

Once the Zone types have been configured, users have the ability to 

track the Zones within the parcel window. 

 

Go to SEARCH>PARCEL and type in the desired parcel. 

 

From the Parcel window, locate the small green PLUS SIGN on the left 

side of the screen next to Zones.  
 

                                    
 

                               

Check the applicable zone(s) for the parcel.    

 

Click SAVE on the parcel to save any changes. 

 

 

Zones can be tracked within the IPS program on the Parcel level.  As zone changes are made, the history is 

automatically tracked.    

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

Note: Zones have the ability to be printed on custom forms. 

The SHOW HISTORY button will show all 

saved changes that have been made to a 

parcel. Those displaying in red text indicate 

when a zone was “deselected” and green 

text for when a zone was “selected”. 

 

The zones bound in a green box represent 

the currently active zones. 
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BAS Monthly Tip Sheet 
 Report- Action by Action Type 

 
 

 

  

    

 

 Report Type-  Select Action by Action Type 
 

 Action Types- Choose Action Types to include  
       on report  

 

 Sort By-  Choose from these options: 
o Action Date 
o Number 
o Complaint Type 

 

 Date Range-  Specify the reporting period 
 

 Include Voids – Checking this box will include voided 
records 

 

 Show Complainants – Show/remove complainant name 

Once you have determined all the criteria, click CREATE REPORT.  

 

Note: This report is 

also located on the 

right side of the 

Complaints window or 

can be printed from a 

Complaint record. 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

At the end of the year, you may be required to report activities performed by your office.  The Action by Action 

Type report lists all selected Actions for Complaint records within a specified date range.    

 

 

From the REPORTS menu, select COMPLAINTS/VIOLATIONS: 

 

 

This report has the ability to be exported to a PDF document or an Excel spreadsheet 

by clicking on EXPORT within the Report Viewer screen. 
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BAS Monthly Tip Sheet 
 Quick Notes 

 
 

 

            
    

 

                                        

      
 
 

 
 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

  

Quick Notes are a great way to save time when entering 

canned responses to Permit, Complaint and Project level 

inspections. They can also be utilized within the violation 

window for the Area Involved, Corrective Action, and 

Notes fields. 

To enable Quick Notes go to FILE>SYSTEM 

PREFERENCES>GENERAL and check the box for “Enable 

editing of Quick Notes”. 

 

 

 

 

INSPECTION LEVEL QUICK NOTES 

 Search for the desired record. 

 Click on the INSPECTIONS tab and open the 

relevant inspection. 

 Click on the QUICK NOTES button  

 When the Quick Notes pop up appears, click 

ADD, type in the desired text, and click SAVE. 

 Select the note and click INSERT to add the 

text to the inspection. VIOLATION LEVEL QUICK NOTES 

 Within the COMPLAINTS tab, search for the 

desired record. 

 Add or open an existing violation. 

 Click on the QUICK NOTES Button next to the  

AREA INVOLVED, CORRECTIVE ACTION, or 

NOTES fields. 

 When the Quick Notes pop up appears, click 

ADD, type in the desired text, and click SAVE. 

 Select the note and click INSERT to add the 

text to the chosen field. 

  

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

Note:  Once a Quick Note is added, it will be saved for future use. 
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BASBASBASBAS    Monthly Tip SheetMonthly Tip SheetMonthly Tip SheetMonthly Tip Sheet    
����    How to How to How to How to AddAddAddAdd/Edit/Edit/Edit/Edit    AttachmentsAttachmentsAttachmentsAttachments    

    
Adding attachments is a simple yet powerful feature of IPS. This tip sheet will detail how to add and edit 

those attachments while giving some examples of common usages. 

 

When on a parcel, record (permit, complaint, etc.), inspection, or contact, attachments can be added via the 

ATTACHMENTS or IMAGES\DOCS tab. Simply click the ADD button and browse to the location of your file in the 

window that appears. 

 

 

 

 

 

 

 

 

 

 

Once added, any attached items can be opened by double-clicking on them. Each file will open in the default 

program set for that type on your computer (.pdf in Adobe, .doc in Microsoft Word, etc.). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Below are some great uses for attachments: 

 

Parcel – Title searches, surveys, photos of the front of property or driveway for difficult to identify parcels. 

Record – Scanned-in copy of application, digital copies of any relevant plans, scans of any waivers pertinent to 

the proposed work, meeting minutes, audio/video recordings of board meetings. 

Inspection – Photo/video of the area in violation, progress pictures of new construction. 

Contact – Scans of contractor insurance/licensure information, identification cards. 

Attachments can be removed by selecting one and 

clicking the DELETE button. Deleted attachments can still 

be viewed and accessed if you check the ‘Show Deleted 

Attachments’ box. 

Attachments can also be edited by selecting one 

and clicking the EDIT button. Editing an 

attachment allows you to change it’s name, as 

well as add a description. 

If you have any questions, please contact a BAS Customer Service Representative at 

518.371.6869 or support@basgov.com and someone will be happy to answer your 

questions. 

Note: The location does not necessarily need to be on your local 

hard drive. Shared folders, attached drives, cameras, and memory 

cards can be read as well. 



DecemberDecemberDecemberDecember    2016201620162016 

BAS Monthly Tip Sheet 
� Inspection Entry in IPS 4.0 

 
 

 

  

         
   

If you have any questions, please contact a BAS Customer Service Representative at 

518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

IPS 4.0 brings some new functionality to Inspections. Inspections added to the IPS program can be tracked on 

each record and later reported on to gauge productivity or tally results. Scheduled Inspections will show on the 

IPS Start Screen and on the Mobile App calendar. 

 

Date: Click on the calendar drop down to assign a date to the Inspection. Checking the box will assign the current date. 

Duration: A Duration can be set to help schedule inspections. The Calendar Screen of the Inspections module will show 

the durations, allowing you to see what is already scheduled and plan out other inspections.  

Inspector: Choose the intended Inspector from the pre-defined list. Clicking on the calendar icon to the right of the 

dropdown will show you a calendar view of their other scheduled inspections for that day/week. Checking the Show All 

Inspectors box will allow you to choose from all inspectors, not just inspectors in the current Department. 

Result: Choose the Result from the drop down (custom result types can be added). 

Notes: Add any Inspection notes or comments. Quick Notes can also be utilized here (see August 2016 tip sheet). 

Attachments: Add attachments such as photos, third party inspection certificates, etc. You can drag and drop the 

attachments in, and even edit their names/descriptions afterwards. 

Reschedule: This button allows you to quickly create a new inspection while retaining the same Inspection Type and 

Inspector. All you need to do is assign the re-inspection date! 

IPS can integrate with Outlook, which allows you to detect when an inspection conflicts with another calendar 

appointment (e.g. vacation day or doctor’s visit) as well as push scheduled IPS inspections to your Outlook 

calendars. This helps prevent double-booking of appointments and provides better visibility into staff availability. 

Updates are included in your yearly maintenance, so feel free to contact us and schedule your update. 

Double-click on an inspection to open the Inspection Window. 
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BAS Monthly Tip Sheet 
 Fee Type Maintenance 

 
 

 

 
           
 
 
 
 
 

          

      
 

IPS can be used to calculate fees based on criteria such as square feet, units, and cost. 

To maintain fees, go to the menu located under Maintain > Fees and Payments > Fee Types. 

Select the Fee Type that you would like to edit from the drop 

down menu at the top, or click the NEW button to create a Fee 

Type. 

The Modules tab shows you which areas of the program the 

selected fee is available for (you must specify at least one). 

 

 

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to assist. 

NOTE: If a fee is no longer needed, uncheck the ACTIVE box and click SAVE.  This will deactivate the fee preventing 

future use, while keeping the fee history on existing records.  Always deactivate fees if they are no longer in use, do 

not attempt to delete them. 

 

The Fee Scale tab is where you can configure more complicated fees, such as those 

based on different levels of square footage or cost. 

The Details tab is where you can select the criteria on which the fees are based (custom 

criteria can be added by clicking Fee Based On), and specify a minimum amount if needed. 

The example to the left will calculate based on the 

square footage that you enter. The first 1000 will be 

$0.15/ft2, the next 4000 (1001-5000) will be an 

additional $0.10/ft2, and anything more than 5000 

will be an additional $0.05/ft2. This fee changes as the 

units (square footage) goes up. 

The example to the right will calculate based on 

square footage in a series of fixed levels. Anything 

between 1-1000 will be $300, between 1001-5000 

will be an additional $200 ($500), and anything more 

than 5000 will be an additional $100 ($600).  

mailto:support@basgov.com


February 2017 

If you have any questions, please contact a BAS Customer Service Representative at 

518.371.6869 or support@basgov.com and someone will be happy to answer your 

questions. 

The Schedule screen has 5 different views for each inspection type: 

1. Inspections Due – parcels coming due for re-inspection in a timeframe. 

2. Overdue Inspections – parcels past due for re-inspection. 

3. Last Failed Inspection – parcels that have failed a prior inspection. 

4. Scheduled Inspections – parcels with scheduled inspections in a timeframe. 

5. High Detail – all parcels requiring that type of inspection. 

When you select a parcel in the list, an 

inspections view will appear on the right 

side of the screen. This will show you the 

previous Periodic Inspections of that type 

for that parcel. You can double click any 

of them to view their details, checklist, 

attachments, etc… 

You can also schedule new 

inspections by clicking the 

SCHEDULE INSPECTION 

button near the top and 

entering basic information 

about the inspection.  

That way, when using the 

views mentioned above, 

you will be able to see at a 

glance which inspections 

are coming up. 

BAS Monthly Tip Sheet 
����    Scheduling Periodic InspectionsScheduling Periodic InspectionsScheduling Periodic InspectionsScheduling Periodic Inspections    in IPS 4.0in IPS 4.0in IPS 4.0in IPS 4.0    

    
 

 

 

 

 

 

The Schedule screen of IPS (located under the Inspections tab) is an area for searching, viewing, and scheduling Periodic 

Inspections. This screen can also be used to batch print upcoming inspection notices. 

The columns in any of 

these views can be used 

to sort and filter the  

information. Clicking a 

column header will sort, 

and clicking the FUNNEL 

icon will display filtering 

options. You can even 

turn columns on or off 

by right clicking a 

column header. 

Parcels are included in a specific inspection category based on the presence of tags or attributes on that property. 

For review, our April 2014 Tip Sheet covers tagging parcels. 
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BAS Monthly Tip Sheet 
 Approvals in IPS 4x 

 

 
 

The newest version of IPS (4x) includes the capability to track Approvals on records. If certain groups, boards, or 

departments are required to sign off on something, that can now be tracked in the program. 

The Start Page of IPS now includes 

an area called OUSTANDING 

APPROVALS. This is an easy place 

for Members of Approval Groups to 

see records where their input is 

required. You can double-click to 

view the Approval, or right click to 

view the parent record. 

Approval Groups are configured in the Maintenance area of the program under Approvals. You can create different 

Approval Groups, add Members to them, and create custom approval Statuses. 

After setting up your Approval Groups, the next step is to specify where their input is required. 

 

Default approvals can be configured in the Permits, Complaints, and Projects Type maintenance windows. 

 

Once a record has been started, any defaults will copy down, and can then be managed from the Approvals tab.  

In the example above, the Approval Groups of Building, Electrical, Plumbing, and Fire Safety are assigned to this 

record, meaning their input is needed. At a glance, the current status, user who conducted the review, any 

comments, and the last modifying user can be seen. 

Additional Approvals can be assigned to records manually by clicking the ADD button. 

 

An Approval can be edited by either double-clicking it, or selecting it and clicking the EDIT button. 

 

An Approval can be deleted by selecting it and clicking the DELETE button. Any deleted approvals can be shown in 

the list by checking the ‘Show Deleted Approvals’ checkbox at the bottom-left of the tab. 

 



March 2017  

In the example above: 

 Building Approval has been marked ‘Approved’ with a comment. 

 Electrical Approval has been left ‘Active’ with a comment. 

 Plumbing Approval has been marked ‘Conditionally Approved’. 

 Fire Safety Approval has been marked ‘Denied’ with a comment. 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your 
questions. 

Upon opening an 

Approval, a member can 

edit the status, dates, 

and add comments. 

Note: Users that are not 

a member of the group 

will have read-only 

access. 

The status of ‘Conditionally 

Approved’ can be used to 

specify additional 

requirements within an 

Approval. 

Conditions can be added and 

then marked as Met, Not Met, 

or Waived as their status 

progresses (or they become 

no longer necessary). 

mailto:support@basgov.com
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BAS Monthly Tip Sheet 
����    Projects Projects Projects Projects Module OverviewModule OverviewModule OverviewModule Overview    

    

The Projects module in IPS is designed for tracking a user-defined list of Planning and Zoning records such as 

Variances, Rezoning, Special Use permits, Subdivisions, Site Plans, etc.  

 

A Project record allows you to track information such as: 

• Application and Expiration dates 

• Status 

• Attachments such as blueprints, letters, pictures, 

recordings, etc… 

• Contacts 

• Custom Attributes 

• Use and Area Variances 

• Fees and Payments 

• Bonds and Escrows 

• Approvals 

• Inspections 

• Related Permits 

Custom Actions can be created to track 

anything that might happen during the life 

of a project. Some common examples 

include Notices, Meetings, Hearing Dates, 

and Planning/Zoning Board Actions. 

 Custom forms can be added to print from 

the Projects Module; examples include 

area notices, approval/denial letters, 

memos, and resolution letters. 

Some of the functionality specific to the Projects module will be covered in more detail in upcoming Tip Sheets! 

If you have any questions, please contact a BAS Customer Service Representative at 

518.371.6869 or support@basgov.com and someone will be happy to answer your 

questions. 



June 2017 

BAS Monthly Tip Sheet 
 Project Bonds 

 

 

 

  

 

 

 

 

 

 

 

 

The Projects module in IPS can keep track of Bonds/Escrows that are used during the life of a project. 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to assist. 

Bonds are handled on the Bond tab of a 

Project record. 

To enter a Bond on a project, click the 

START NEW BOND button. 

 
Information such as the type of Bond, Format, Balance, 

Expiration Date, Applicant, and Poster can be entered 

when creating a Bond. 

After creating a Bond, you can track withdrawals and deposits in the Activity area. Simply enter the amount and a 

reason, and then click the + button to make a deposit or the – button to make a withdrawal. Activity will update the 

Current Balance of the bond accordingly. 

A Bond can also be completely voided by entering any amount (usually the current balance) in the Activity area, 

giving a reason, and clicking the VOID button. Please note that this action is irreversible. 

 The Conditions area can be used to specify various 

conditions that have to be met regarding the bond 

or its withdrawals/deposits. 

mailto:support@basgov.com
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BAS Monthly Tip Sheet 
 Project Actions and Reports 

 

In IPS 4x, Process Tracking in Projects has been replaced with Actions. Just like in the Complaints module, custom 

user-defined Actions can be created to keep track of anything that might happen during the life of a Project. 

Additionally, Project Reports help you to gather and display information on your Projects in an orderly way. 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your 
questions. 

Project Actions are configured in Maintenance -> Project -> Action Types.  

Clicking the ADD button next to Actions on 

a Project will bring up a window with all 

the available Actions. You can also Edit 

and Delete existing Actions. 

Examples include Hearing Dates, Reviews, 

Meetings, Notices Sent, and Notes. 

The Hearing Schedule Report will generate a list of Actions with Hearing Dates for your different Approval Groups in 

a time range that you set. This is very useful for getting an agenda for upcoming hearings or meetings. 

Project reports can be found in Reports -> Project. 

These reports include your Open or Expired Projects, Actions on your Projects, Actions that have Hearing Dates, and 

Open or Released Bonds. These reports can be run for a specific time frame, and for all or specific 

Project/Action/Bond Types. This ensures that you can get a report for exactly what you want to see. 

Clicking an Action will bring up a new 

window for entering the information. Two 

new fields are available for Actions: Hearing 

Date and Approval Group. 

 

mailto:support@basgov.com
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BAS Monthly Tip Sheet 
 Start Page in IPS 4.4.7 

 

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to assist. 

The Start Page is a great place to see your own workload, that of another inspector, as well as keep track of 

scheduled inspections for everyone. 

The Show All Inspections area allows you to keep track of all SCHEDULED inspections. You can view a specific 

inspector’s schedule, or select ALL to see everyone. You can also set a specific date range you’d like to view. Checking 

the Failed Inspections Only box will filter to only failing inspections. 

The Show Scheduled Inspections area will show you past 

due or upcoming SCHEDULED inspections that have no 

result recorded. You can view results for a specific 

inspector, or select ALL to see everyone.  The 

Timeframe can be set to Today, This Week, or Next 

Week. 

The Show Assigned area displays current, open 

records assigned to an inspector. You can also 

select ALL inspectors for a broader view of active 

items. 

The Show Recent area displays the items that you have been working on recently.  

The Outstanding Approvals area is covered in great detail in our March 2017 Tip Sheet. 

mailto:support@basgov.com
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If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your 
questions. 

The new and improved PARCEL HISTORY tab allows 

users to see all activity on a parcel and its sub-parcels. 

It is an invaluable tool for viewing/opening any 

transactions on a parcel, as well as a great place to 

initiate new records. 

The ADD HISTORY button allows users to add simple historical transactions and details to 

the record, without the need of creating an entire permit, complaint, etc. 

 

 

From the PARCEL HISTORY tab, start by searching for a 

parcel. Select the intended parcel to see the history 

below. 

 

 

Results can be filtered down by checking or unchecking the boxes for Open or Closed Items; Applications, Permits, 

Complaints, Inspections; etc. Users also have the ability to filter the results to a specific date range. Be sure to click 

the refresh button to see the most up to date results. Any of the activity in the list can be opened with a double-click. 

 

Select a record in the list and click the new VIEW ATTACHMENTS button for a shortcut to 

see that item’s attachments. 

  

mailto:support@basgov.com
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BAS Monthly Tip Sheet 
 Adding New Permit Types in IPS 4.x 

 
 
 

 

           

   

 

 

 

 

 

 

 

 

 

 

 

To add a new permit type, go to MAINTENANCE -> PERMIT -> PERMIT 
TYPES and click on NEW. The following fields are available: 
 

 Name - The display name of the permit type. 

 Full Name -The full (long) name of the permit type (optional). 

 Expires in - The default expiration period for this permit type. 

 Renewable - Flags this type as renewable (with optional fee) 

 New Home Construction- Flags the permit type to show on the 
F.W.Dodge report (optional). 
 

Click SAVE to activate the tabs on the lower portion of the screen, 
which allow you to set which Fees, Inspections, Forms, User Defined 
Attributes, and Approvals are available for that permit type, and 
optionally which are added by default to new records. 

Fees: Moving a fee from the left column to the right column 
with the arrow button makes it available for the permit type, 
and checking the box will make it a default fee. 

Default Inspections: To default application level inspections, 
click the pink button and move the desired inspection type 
from the left column to the right column with the arrow 
button. To default permit level inspections (i.e. upon permit 
issuance), click the green button and do the same. 

Forms:  Moving a form from the left column to the right 
column with the arrow button will make it available. 

User Defined Attributes:  Place a check mark next to a user 
defined attribute on the left to make it a default. An optional 
default value can also be specified, if desired. 

Approvals: Moving an approval group from the left column to 
the right column with the arrow button makes it available, and 
checking the box will make it default. 

 

 

 

When adding new Permit Types; remember to also 

add the type to a Permit Group. Permit Groups are 

where the number sequence resides in the IPS 

program. Permit Groups can be found within 

MAINTAIN>PERMIT>PERMIT GROUPS 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

New permit types can be added, and their available Fees, Forms, Inspections, etc. can be configured within the 

Permit Type Maintenance area of the program. 

 

When adding new Permit Types; remember to also add the 

type to a Permit Group. Permit Groups are where the number 

sequence a permit receives is defined. Permit Groups can be 

found within MAINTENANCE -> PERMIT -> PERMIT GROUPS. 

 

NEW TO 4X is the necessity to add a new permit type to a 

department in MAINTENANCE -> GENERAL -> DEPARTMENTS. 

Select the department from the top dropdown menu, click on 

the Record Types tab, click the Permit radio button, and use 

the arrow button to move the new permit type from the left 

column to the right column to make it available. 

mailto:support@basgov.com
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BAS Monthly Tip Sheet 
 How to “Generate Areas” or Create Sub Parcels in 4x 

 
 

 

   
 

 

 

 

                                        
     

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your 
questions. 

The Generate Areas feature can be helpful for 

those parcels that share the same tax map 

number but need to be broken out separately 

(e.g. mini malls, multi dwelling units or 

mobile home communities). Generating these 

areas separately allows for inspections, 

permits or complaints to be assigned to sub-

parcels individually. 

 

You can find this feature on the RELATED 

PARCELS tab on any parcel window. 

 

Click GENERATE AREAS and enter the number of areas 

that are needed. If a prefix is necessary (unit, apt, 

suite), one can be added at this time. You will have the 

opportunity to change this information for each 

individual area after the sub-parcels are generated. 

To generate your areas, click the OK button and then 

SAVE when you are done. 

 

Upon clicking OK and SAVE, a new section will 

appear showing the sub-parcels. By clicking the 

BLACK TRIANGLE, the new areas will be listed below. 

They can now be named and/or given their own 

address. To do so, double click on the first new 

parcel and choose EDIT in the resulting window. As 

you can see you can now change the basic parcel 

information, TAGS can be entered at this time as 

well. Press the OK and SAVE buttons to complete 

this new sub-parcel and repeat the process for each 

new area. 
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December 2017 

BAS Monthly Tip Sheet 
 Adding New Complaint Types in 4x 

 
 
 

 

          

  
    

 

                                        

      
 
 

   

When adding new Permit Types; remember to also 

add the type to a Permit Group. Permit Groups are 

where the number sequence resides in the IPS 

program. Permit Groups can be found within 

MAINTAIN>PERMIT>PERMIT GROUPS 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

To add a new complaint type, Go to MAINTENANCE -> COMPLAINTS -> 
COMPLAINT TYPES and click on NEW.  The following fields are 
available: 
 
 

 Complaint Type Name- The display name of the complaint type 

 Description- Description of the complaint type (optional) 
 

 

Click SAVE to activate the tabs on the lower portion of the screen. 

These tabs allow you to set which Forms, User Defined Attributes, User 

Defined Actions, and Approvals are available for the selected 

complaint type. Defaults can be set so that they are automatically 

added to new records upon creation. 

Forms:  Select the desired forms from the left side and use 

the arrow buttons to move them to the right side. 

User Defined Attributes:  To add UDAs, place a check in the 

box for the desired defaults. 

Action Types: Select the desired actions from the left side 

and use the arrow buttons to move them to the right sight. 

Place a check in the box for the desired defaults. 

Approvals: Select the desired approvals from the left side and 

use the arrow buttons to move them to the right sight. Place 

a check in the box for the desired defaults. 

 

 

New complaint types can be added within the Complaint Type maintenance window. Forms, User Defined 

Attributes, Actions, and Approvals can also be configured here. 

 

When adding new Complaint Types; remember to 

also add the type to a Complaint Group.  Complaint 

Groups are where the number sequence resides in 

the IPS Program. Complaint Groups can be found 

within MAINTENANCE -> COMPLAINTS -> 

COMPLAINT GROUPS. 

*NEW to 4x- DEPARTMENTS*  

It is now necessary to add a new complaint type to a 

department.  Departments can be found within 

MAINTENANCE -> GENERAL -> DEPARTMENTS. Select the 

department from the top drop-down menu and click on the 

Record Types tab. Click the Complaint radio button, and use 

the arrow button to move the new complaint type from the 

left column to the right column to make it available. 

mailto:support@basgov.com


January 2018 

BAS Monthly Tip Sheet 
 Adding New Project Types in 4x 

 
 
 

 

          

  
    

 

                                        

      
 
 

   

  

When adding new Permit Types; remember to also 

add the type to a Permit Group. Permit Groups are 

where the number sequence resides in the IPS 

program. Permit Groups can be found within 

MAINTAIN>PERMIT>PERMIT GROUPS 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

To add a new Project Type, Go to MAINTENANCE -> PROJECTS -> 
PROJECT TYPES and click on NEW.  The following fields are available: 
 
 

 Name- The display name of the project type 

 Description- Description of the project type (optional) 
 

 

Click SAVE to activate the tabs on the lower portion of the screen. 

These tabs allow you to set which Forms, Default Fees, User Defined 

Attributes, Action Types, and Approvals are available for the selected 

project type. Defaults can be set so that they are automatically 

added to new records upon creation. 

Approvals: Select the desired approvals from the left side and 

use the arrow buttons to move them to the right side. Place a 

check in the box for approvals that should be added to the 

record automatically on creation. 

Action Types: Select the desired actions from the left side 

and use the arrow buttons to move them to the right side. 

Forms:  Select the desired forms from the left side and use 

the arrow buttons to move them to the right side. 

Default Fees: Place a check in the box for the desired 

defaults. 

User Defined Attributes:  To add UDAs, place a check in the 

box for the desired defaults. 

New types of Planning or Zoning records can be added within the Project Type maintenance window. 

 

When adding new Project Types; remember to also 

add the type to a Project Group.  Project Groups are 

where the number sequences reside in the IPS 

Program. Project Groups can be found within 

MAINTENANCE -> PROJECTS -> PROJECT GROUPS. 

*NEW to 4x - DEPARTMENTS*  

It is now necessary to add a new project type to a 

department.  Departments can be found within 

MAINTENANCE -> GENERAL -> DEPARTMENTS. Select the 

department from the top drop-down menu and click on the 

Record Types tab. Click the Project radio button, and use 

the arrow button to move the new project type from the left 

column to the right column to make it available. 
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April 2018 

BAS Monthly Tip Sheet 
 Batch Printing Ability in Searches in 4x 

 
 

 

 
 

 
   
                                                
     

 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

To mass generate Expired 

Permit Letters you will 

perform a Permit Search.  

You will search OPEN 

permits due to expire in a 

specific date range.   Hit 

SEARCH to display records.   

IPS allows users to quickly address the issue of expired permits which require attention. 

 

Click the Print icon and a list of your 

available forms will display.  Select the 

form you wish to generate.   

If you do not have an Expired Permit 

Letter, please contact us and we will 

be happy to provide you with some 

samples.  

 

 

Documents will be prepared and 

sent to a print preview for viewing.  

 

 

 
It is a good idea to 

proofread the preview 

for errors prior to 

sending documents to 

your printer. 

Reminder: When 

printing letters or 

envelopes, always check 

to make sure the 

addresses are complete! 

 

 

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your 
assist.. 
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May 2018 

BAS Monthly Tip Sheet 
 Recording Stop Work Orders in 4x 

 
 

 

 
 

 
   
                                                
     

 

 
 
 

 

 
 
 

 

 

 

 

 

   

Users can easily track the issuance of a Stop Work Order 

in the Complaint module via the Actions feature.  When 

documented properly, users have the ability to report on 

the number of stop work orders issued in a reporting year. 

To add a new action type, Go to MAINTENANCE -> 

COMPLAINTS -> ACTION TYPES and click on NEW. 

Enter “Stop Work Order Issued”, check Complaint and Click 

SAVE.   In this example, the color code has been customized 

to display in Red. 

Actions may be defined to track a variety of information 

through the Design Action Screen tab. 

 

 

 

 

 

 

 

User-Defined Actions must be added to the Complaint types.   To make 

your actions available, Go to MAINTENANCE -> COMPLAINTS -> ACTION 

TYPES.   

Select Complaint Type from the pull-down.   Click the Action Type tab.  

Highlight and move all actions you wish to have available to the left side 

of the screen.  You will need to do this process for all complaint types 

which you want this action available for.  

 

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your 
questions. 

 

For a Stop Work Order, you may want to track the following: 

• Contact- the party the Stop Work Order was issued to 

• Inspector-  the party that issued the Stop Work  

Further options for customization include what action 

information to display on the main record, and what data 

fields are required for a specific action to be added. 

 

 

 

 

 

v 
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June 2018 

BAS Monthly Tip Sheet 
 Reporting Stop Work Orders in 4x 

 
 

 
 

 

 
   
                                                
     

 

 

 
 
 

 
 
 

 

 

 

 

The Action by Action Type report in the Complaints 
module gives users the ability to report on the number of 
Stop Work Orders issued in a specified date range. 

From the REPORTS menu, go to COMPLAINT -> ACTION BY 
ACTION TYPE. 

Select the ACTION TYPES you wish to report, in this 
scenario you would select “Stop Work Order”.  
 

Once you have determined all the criteria, click CREATE REPORT.  

This report has the ability to be exported to a PDF document or an Excel spreadsheet by 
clicking on EXPORT within the Report Viewer screen. 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to assist. 

Select from the following to customize your report: 
 

 Sort By-  Choose from these options: 
o Action Date 
o Number 
o Complaint Type 

 
 Date Range-  Specify the reporting period 

 
 Include Voids – Checking this box will include voided 

records 
 

 Show Complainants – Show/hide complainant name 



August 2018 

BAS Monthly Tip Sheet 
 NEW Parcel Links in 4.4.8 

 
 
 

 

            
    

 

                                        

      
 

 

   

  

When adding new Permit Types; remember to also 

add the type to a Permit Group. Permit Groups are 

where the number sequence resides in the IPS 

program. Permit Groups can be found within 

MAINTAIN>PERMIT>PERMIT GROUPS 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to assist. 
 

A new feature of IPS 4.4.8 is the ability to enable links on the Parcel window to sites such as Image Mate Online, 

GIS mapping, and Google Maps. These links will take you to those sites with information specific to that parcel. 

 

Image Mate and GIS links work off specific parcel information, so valid Assessment Data for your parcels is necessary. Your 
municipality must have access to Image Mate and GIS services. Please contact us to configure these links for you. 

Note: To enable this feature, you must be on IPS version 4.4.8 or higher. 
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September 2018 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

BAS Monthly Tip Sheet 
 Using The Display Attribute For Parcel History 

 
 
 Records in IPS can be visibly linked in Parcel History by using the Display Attribute set in System Preferences. 
 

 
 

 
 

 
 

 

 

 

 

 

 

 

 

  

In the Maintenance > General > 
User-Defined Attribute Types 
menu, create an attribute with that 
same name and check the boxes to 
make it available for the Permit, 
Complaint, Project, and Periodic 
Inspection Modules. 

Start by going to the File menu 
and click System Preferences.  
In the Parcel History tab, enter 
the name of the attribute you 
plan to use. 

The Attribute Record column 
will display the value for that 
attribute on the record. In 
the example pictured, the 
“File” attribute was added to 
records with a value of “XYZ 
Subdivision.” No matter what 
lot or record type, it is easy to 
tell what records are related 
to the creation of the 
subdivision. 
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October 2018 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your questions. 

BAS Monthly Tip Sheet 
 Permit Safeguards 

 
New safeguard options have been implemented to prevent the issuance of an application or the completion of 
a permit record unless all fees are paid, all inspections are passed, and/or all approvals have been approved. 
 

 
 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check the boxes to enable any 

safeguards which you desire.     

Prevent Permit Issuance allows you to 

the stop the issuance of a permit.  

Prevent Permit Completion allows you 

to the stop the completion of an issued 

permit.   

  

    

Under the File menu, click 
System Preferences.   
 
These switches are located 
in the Permit tab. 

Note: These safeguards can be easily turned off if you decide you no longer wish to have them active.    

Simply go back into the System Preferences and uncheck those you wish to disable.    

 

The Action button will not allow the user to proceed until 

all conditions are met.  The items which need to be 

addressed will display in red.    

 

Once all conditions are met, the OK button will become 

live and the user can continue forward.    
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November 2018 

BAS Monthly Tip Sheet 
 Inspection Scheduling Tools 

 
IPS 4.x versions have a variety of ways to help with the scheduling of inspections and help you see who is where when. 

 

  

  

 
 
 

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to assist. 

 

From any inspection window you can select an inspector 
and an approximate date, then click the calendar icon on 
the right side of the Inspector dropdown box.  This can 
be done from existing inspections or from new 
inspections you’re creating. 

 

The inspector’s calendar for the target week will pop up in 
a new window.   Hovering your mouse over any of the 
inspections will give more details like address, inspection 
type, and exact scheduled times. 

Note: Multiple inspections can be scheduled for the same 
time period. 

 

There is a calendar located in the 
Periodic Inspection module where you 
can select multiple inspectors and see 
all of their inspections for a Day, 
Week, or entire Month by clicking on 
their respective buttons. 



December 2018 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to assist. 

BAS Monthly Tip Sheet 
 Create New Parcel in 4x 

 
New parcels can be created in your IPS system when needed.  To avoid duplicates, it is recommended to first 
check both your active and inactive parcels prior to creating a new parcel.    
 

 
 
 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Fill in the desired information as follows: 

• Identifier:  Tax Map Number or SBL  

• Name (optional):  Name of Business or Unit # 

• Number: Street Number only 

• Address:  Street Name only 

• City:  City 

• Zip:  Zip Code 

• Municipality: Select Municipality from pull-down 

After all required items have been entered, click the ADD 

OWNERS button. 

 

Under the File menu, click NEW and then PARCEL.    
 
Note:  New parcels can NO LONGER be created from an 
Application or the Parcel History window.    

Confirm that the parcel details are correct.  If any 

changes are needed, use the BACK button to do so. To 

finalize the creation of the new parcel, click CREATE 

PARCEL.   

Once your New Parcel has been added, you will be able 

to use it to add new records such as permits, complaints, 

projects, or inspections. 

 

Click ADD AN OWNER and your address book will display. 

It is recommended to search the address book before creating a 

new entry.   The left portion of the screen allows you to do this.   

If the party does not exist, create the contact by filling in their 

information on right side.  When finished, click CLOSE.  

The owner information will display on the new parcel window.   

Click CONFIRM.   

* IMPORTANT*- The 
Name field is NOT where 

you enter the  
Owner’s Name. 
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February 2019 

BAS Monthly Tip Sheet 
 Valuation Field in IPS 4.x 

 
The Valuation portion of the Fees and Payments tab has been moved to an independent field.  Valuations 

can now be added without necessitating a fee.  

  
 
 

 

 

 

 

Note: if you forget to add the valuation during the payment process, or if it changes with the scope of the 

work, you no longer have to void payments to make adjustments. 

 

 

 

If you have any questions, please contact a BAS Customer Service Representative at 
518.371.6869 or support@basgov.com and someone will be happy to answer your assist. 

To add a valuation, choose 

the FEES and PAYMENTS tab, 

click into the VALUATION 

field, type in the desired 

amount, click SAVE 

VALUATION. 

With valuations tracked, you can take 

advantage of all reports in IPS that include 

that data field:  

 Permit Types 

 Permit Monthly 

 Permit Valuation Summary 

 Monthly Count for Census 

 F.W. Dodge Report 
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March 2019 Monthly Tip Sheet 
 Adding and Maintaining Fee Groups in 4x 

 
 

  
 

 

 

 

 

  

Fee Groups can be setup to help users to group their fees according to Departments or by Town 

Account numbers. 

 

The Fee Group tool is located under the 

MAINTENANCE tab.   Select FEES AND 

PAYMENTS and then choose FEE 

GROUPS.  

 

 

Now that your Fees have been sorted by 

groups, you will be able to run reports 

and see a breakdown of your fees, as 

shown. 

Reports can be printed or exported for 

emailing. 

 

 

Fee Groups can be broken down according to Department 

Type (e.g. Plumbing), or by Town account numbers. 

To add a new Fee Group, click on the NEW button and add the 

new Fee Group name and Description, if needed. 

Unassigned fee types will populate on the left side, highlight 

the fee you would like added into your new group and click the 

ARROW in the center to push it to the right side. 

Make sure to hit the SAVE button to complete the process. 

 

 



 

April 2019 Monthly Tip Sheet 
 How to Select a Different Parcel in 4x 

 
 

  
 

 

 

 

  

Have you ever begun a new application or complaint only to find out that you were provided with 

the wrong parcel address?  

 

The SELECT DIFFERENT PARCEL button will allow you to keep 

everything from the intended permit, complaint, or project 

and switch it to a different parcel. Simply click on the SELECT 

DIFFERENT PARCEL button and enter the correct parcel.   

 

Note: This feature is only available from the Application 

window.  

 

 

After selecting the new parcel, a warning box will appear 

asking if you would like to replace the contacts. Your 

contact information from the previously selected parcel 

is most likely still desired, so you can click No.  

WARNING:  If you click Yes, all of your existing contacts 

(including contractors) will be overwritten.  

 

 

Select a different parcel can also be used to migrate 

permit and complaint records from one parcel to 

another.    

 

 



 

May 2019 Monthly Tip Sheet 
 How to Populate/Edit the Codebook in 4x 

 
 

  
 

 

 

 

  

Updating the IPS system with the appropriate International, State or Local code(s) gives you the 

ability to reference the code when issuing violations from the Complaint or Periodic Inspection 

modules.  

 

The Codebook structure is shown on the left 

side of this window, and text for the codes is 

added to the right side.   You can create as 

many chapters, subchapters, sections… as 

needed.  

 

Before entering your codes, it is important to 

layout the proper structure to ensure things 

stay organized.   

 

 

How to Enter NEW Information:    

 

1. CODEBOOK-   Click the NEW button and name the book accordingly.   

 

2. CHAPTER- Highlight the appropriate Codebook.  Click the ADD HEADER button and name the Chapter.   

 

3. SUBCHAPTER (Section)- Highlight the appropriate Chapter.  Click the ADD HEADER button and give it a name. 

 

4. CODE- Highlight the appropriate Section. Click the ADD ITEM button and give it a name. 

 

 

 

To Access the Codebook, go to MAINTENANCE and select COMPLAINTS or PERIODIC INSPECTIONS, and then CODEBOOK. 

 

 

 

1 2 4 3 

Note:  To create additional codebooks and codes, you will repeat the steps above. 

 

 

 



 

 

 

 

IMPORTANT:  Copying and pasting directly from an electronic source or website can bring along unwanted formatting, 

so we recommend copying into Notepad to make sure any special formatting is removed and only plain text remains.  
 

Note:  You can copy and paste data using keyboard shortcuts: CTRL+C and CTRL+V 

 

 

You are now ready to enter the Code……  

 

 

To enter text for a code, simply highlight the 

item on the left and enter the text in the right 

side of the window.  

 

How to EDIT existing Codebook information: 

 

IMPORTANT:  Prior to editing your existing Codebook, please be aware that editing 

this information can affect violations that have previously used that code item.  

 

 

To edit an existing header/code name, you can right click the item and select 

RENAME.  

 

 

 

 

 

 

 

 

 

  

 

To edit the existing code, you can select the code on 

the left and edit the text in the right side of the 

window. 

 

If a header/code is no longer needed, you can select the item and uncheck 

the ACTIVE checkbox. This will make the item unavailable for future use. 

 


